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LIST Accounts 
How do I create a LIST account? 
You can self-register for a LIST account. To do this: 

• Go to the LIST homepage, http://www.thelist.tas.gov.au, and click on Login at the top
right of the page.

• Click on the Create Account button, and enter your details on the registration page.
Enter the security check code shown in the grey box, and read and accept the terms and
conditions.

• Then click on Create User.  An email will be sent to the email address you provided.

• Click on the link in the email to confirm your account. This will take you to a verification
page.

• Enter a password of your choice, and re-type it in the box below. Click Verify. A green
message will appear if the verification process has been completed successfully.

• Click Login at the top of the page, enter your username and password, and click Login.

Your User Profile will appear, with some of the details already completed.  

You will need to enter your contact phone number, email address and address. Then click Update. 

A green ‘Validated’ should now be shown next to your address.  

Click on Home in the blue banner at the top of the page to return to the LIST home page and 
begin your search. 

I’ve forgotten my LIST password - can I reset it? 
Yes, there is a link on the login page of the LIST if you have forgotten your password. Click on Forgot 
your password? Enter your LIST email/username, and the security check code. Then click Reset 
Password. An email will be sent from LIST Help to your email address. Open the email, and click on 
the link. Enter and confirm a new password, and click Update Password. A green message will 
appear if your password has been updated successfully. Click Login (in the top right of the screen) to 
login and begin your search. 

Can I update the contact details for my LIST account? 
Yes, you can update your own contact details once you have logged into the LIST. Click Login on the 
LIST homepage, log in, and then click on My Account at the top right of the page. Your User Profile 
will appear. Clicking on the details shown in blue will make them editable. Once you have made your 
edits, click on the tick to the right to save the changes. 

http://www.thelist.tas.gov.au/
http://www.thelist.tas.gov.au/
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LIST Properties and Titles 
What products can I access through the LIST? 
To see a description of the range of property and title-related products you can access through the 
LIST, click here. 

How much do these products cost? 
To see the latest Fee Schedule, click here. 

I purchased some documents but forgot to save them – can I access 
them again? 
Yes, you can access documents that you’ve purchased within the past 14 days by logging into the 
LIST, and clicking on My Account at the top of the page. Under the Orders and Invoices section, click 
on View Clients Orders. Here you can view a list of your previous orders. You can access an order by 
clicking on the blue icon, and then open the relevant documents by clicking on the PDF links. 

How do I get a copy of my certificate of title? 
Once you have logged into the LIST, click on the Properties and Titles icon to search for a title. Enter 
the Volume and Folio numbers, Property ID number or Property Address, and click Search. Check 
that the search results match the property in question, then click Select Products. The Folio Text and 
Folio Plan together provide a copy of a title search. Select this option and add it to your cart, then 
click on Cart at the top of the page to start the payment process. Click here for more detailed help 
notes on searching a title.   

How do I get a copy of a registered land dealing (e.g. a mortgage, 
covenant or easement)? 
Once you have logged into the LIST, you can search for a copy of a registered land dealing by clicking 
on the Properties and Titles icon, and then clicking on Torrens Scanned Dealings in the column at 
the left. If you know the dealing number you’re searching for, you can enter it in the Dealing No. box, 
and click Search. (If you are unsure of the dealing number, you can purchase a copy of the Folio Text 
to determine the relevant dealing number.)  

Your search results will appear. Check that the dealing number is correct and add it to your cart, 
then click on Cart at the top of the page to start the payment process. Click here for more detailed 
help notes on searching a Torrens Scanned Dealing.  

How do I find the most recent government valuation for a 
property? 
The two most recent government valuations for a property will be shown on the Property Report. To 
purchase a Property Report, log into the LIST and then click on the Properties and Titles icon. Enter 
the Volume and Folio number, property address or Property ID number, and click Search. Check that 
the search results match the property in question, and click Select Products. Select the Property 
Report and add it to your cart, then click on Cart at the top of the page to start the payment process. 

http://www.thelist.tas.gov.au/
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/descriptions.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/fees.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/properties.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/properties.pdf
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How do I find out how much a property last sold for? 
If a property has been sold since 1982, the two most recent sales will be shown on the Property 
Report. To purchase a Property Report, log into the LIST and then click on the Properties and Titles 
icon.  

Enter the Volume and Folio number, property address or Property ID number, and click Search. 
Check that the search results match the property in question, and click Select Products. Select the 
Property Report and add it to your cart, then click on Cart at the top of the page to start the 
payment process. 

If you are also interested in the sales history of a particular property from 1982 onwards, go to the 
Properties and Titles page, click on Property Sales in the column on the left, and then enter the 
Property ID number in the first box and click Search.  The total price and number of sales will be 
shown. Click on Add to Cart, then click on Cart at the top of the page to start the payment process.  
Click here for more detailed help notes on searching Property Sales.  

How do I search for property sales information within a 
municipality? 
Log into the LIST, and click on the Properties and Titles icon. Select Property Sales in the column on 
the left to search for sales within a selected municipality or municipalities. You can set particular 
criteria to search by, including ranges for contract date, sale price, land area, construction year, 
building size and number of rooms. You can also search for particular building, wall or roof types, or 
land use codes, in order to find comparable sales. Click here for more detailed help notes on 
searching Property Sales. 

Can I download a land dealing form to lodge with the Land Titles 
Office? 
Yes, you can download land dealing forms by accessing Tasmanian Online Land Dealings (TOLD). Click 
on the Tasmanian Online Land Dealings icon on the LIST home page. In the main part of the 
Contents page, Land Title Dealings will appear as the second option from the top. Click on the arrow 
at the far right of the Land Title Dealings bar to drop down a list of dealing forms.  

Locate your required dealing type. To view the current fee to lodge a particular dealing with the 
Land Titles Office, click on the blue code to the left of the dealing type. At the right of the Contents 
page, you can access dealing help, open a blank form to download, or open a general guide to 
completing the form. The general guide will identify the additional documents that you will also 
need to lodge with your completed form. 

Dealings can be lodged either: 

• in person at the Land Titles Office, Level 1, 134 Macquarie Street, Hobart
(above Service Tasmania in the Lands Building)

Note: payment of lodgement fees in person at the Land Titles Office can be made by cash, 
credit/debit card or cheque/money order made payable to ‘The Recorder of Titles’. 

• or by post

Land Titles Office 
GPO Box 541 
Hobart, Tasmania 7001 

Note: payment of lodgement fees by post can only be made by cheque/money order made payable to 

http://www.thelist.tas.gov.au/
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/properties.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/properties.pdf
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‘The Recorder of Titles’. 

For help navigating TOLD, click on the About TOLD link on the left of the page. 

I’m a TOLD subscriber, why can’t I see all my options? 
There are two versions of TOLD – the public version and the subscriber’s version. 

If you have previously entered TOLD via the public version (by clicking on the Tasmanian Online 
Land Dealings button on the front page of the LIST), the web browser cache remembers that 
version.  

To overcome this, click on the Properties and Titles button on the front page of LIST, then click on 
the Tasmanian Online Land Dealings option from the column on the left. Click on Login (under 
Supported Documents).  

You will now be logged in. You will only need to do this once, unless you visit the public version 
again. 

How do I get a copy of a Schedule of Easements from a previous 
title? 
Once you have logged into the LIST, click on the Properties and Titles icon, and then click on 
Properties and Titles in the column at the left. Enter the volume of the easement you require and 
click Search. (Note: the prefix SP or a folio number is not required.)  

Your search results will appear. Choose one of the title references beginning with the Volume you 
entered and click the appropriate Select Products. You can now add the Schedule of Easements and 
Plan as a bundle to your Cart in the normal way.  

To view the full Navigating the New Properties and Titles help document, click here. 

http://www.thelist.tas.gov.au/
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/properties.pdf
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LISTmap 
Where is the ‘identify feature’ tool in the new LISTmap? 
The new LISTmap doesn’t have an ‘identify feature’ tool, but you can still query your map quickly 
and easily. Once you have added a layer to your map and you can see it displayed, simply click the 
left mouse button on your map to query the layer. An Identify Results box will appear, and 
information about the feature will be shown. If you have multiple layers displayed that can be 
queried, you can expand these by clicking on the layer name in the Identify Results box. 

For more help with adding, managing and interrogating map layers, or to view the full Navigating 
the New LISTmap help document, click here.  

Can I customise the new LISTmap so that I can display my favourite 
layers easily? 
Yes, you can create bookmarks which will save your favourite layers. Firstly, add the layers you want 
to your map by hovering over the Layers button in the top right of the screen, and then clicking on 
Add Layer.  

Once you have added the layers you want, hover over Tools in the top left of the screen. Click on 
Map Tools, then Create a shareable bookmark, and give your bookmark a name.  

The next time you use LISTmap, hover over Tools, then click on Map Tools, then Open bookmarks, 
and click on the bookmark that you saved. The layers you saved will now be displayed on your map. 

To view the full Navigating the New LISTmap help document, click here. 

When I print a map as a PDF in LISTmap, why is the extent and/or 
the scale of the printed map different to the map on my screen? 
In order for your map to print out at the same extent and scale as the map on your screen, you will 
need to make your browser window the same size as either a landscape or portrait orientation as 
required. 

Where can I view aerial imagery and other information online? 
You can view aerial imagery and other information online through LISTmap, an online map viewer 
that allows you to view or create your own personalised maps of Tasmania using a wide range of 
land-based information. Around 400 layers of spatial information are available for the general public 
to access for free via LISTmap. These layers include property boundaries (cadastral parcels), roads 
(transport segments), local government area boundaries, reserves (public land classification) and 
contours, as well as aerial imagery over the entire state, at different resolutions and for different 
dates. LISTmap also includes the Google imagery and Street View functions.  

You can access LISTmap from the LIST homepage by clicking on the LISTmap icon, or directly via 
https://maps.thelist.tas.gov.au.  

You can also search and view available aerial photography and orthophotography online using the 
LIST Aerial Photo Index Viewer.   

For more information, see the Aerial Photography page of the DPIPWE website. Information on how 
to use the LIST Aerial Photo Index Viewer is available in the help document. 

http://www.thelist.tas.gov.au/
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/listmaphelp.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/listmaphelp.pdf
https://maps.thelist.tas.gov.au/
https://www.thelist.tas.gov.au/app/content/the-list/aerialphotoviewer/
http://dpipwe.tas.gov.au/land-tasmania/aerial-photography
https://www.thelist.tas.gov.au/app/export/sites/default/the-list/aerialphotoviewer/theLIST_Aerial_Photo_Index_Help.pdf
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What browser should I use on my Samsung Galaxy Tablet to run 
LISTmap? 
The best browser to use for Samsung Galaxy Tablets is the device’s native browser Internet. There 
are known issues using the Chrome Browser for LISTmap. 

How do I add WMS to LISTmap? 
There are a range of spatial web services that are available from LIST. For more details, including 
examples of how to connect various systems and devices to LIST services, please download the LIST 
Spatial Web Services Guide. 

How do I access LIST layers in my GIS system via WFS? 
There are a range of spatial web services that are available from LIST. For more details, including 
examples of how to connect various systems and devices to LIST services, please download the LIST 
Spatial Web Services Guide. 

Why am I having problems printing basemaps in ArcGIS? 
Currently there are certain limitations with servers that provide image-based services as they are 
aimed at performance and displaying a quality image on a monitor. 

There are two ways to export Orthophotos from ArcMap to PDF. 

1. If you are using the ArcGIS User Connection:

• from the File menu, use the Export Map option

• In the General tab, set the Resolution to 125 dpi

• In the Format tab, set the JPEG Quality to Best

• This seems to produce a good result when viewed in PDF-XChange Viewer and Adobe
Reader at 100%

2. To create the WMTS Service in ArcMap:

• Open Catalog

• GIS Servers

• Add WMTS Server

• Use the URL
https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/ImageServer/
WMTS? 

To print to PDF: 

• from the File menu, use the Export Map option

• In the General tab, set the Resolution to 300 dpi

• This seems to produce a better result when viewed in PDF-XChange Viewer and Adobe
Reader at 100%.

More information is available from ArcGIS Help. 

http://www.thelist.tas.gov.au/
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/list_spatial_web_services_user_guide.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/list_spatial_web_services_user_guide.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/list_spatial_web_services_user_guide.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/list_spatial_web_services_user_guide.pdf
https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/ImageServer/WMTS?
http://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/ImageServer/WMTS?
http://resources.arcgis.com/en/help/main/10.2/index.html%23//00sp00000013000000
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LISTdata 

Where can I find information about Tasmanian spatial data and 
services? 
You can access LISTdata from the LIST home page by clicking on the LISTdata icon, or directly via 
https://data.thelist.tas.gov.au.   

To view the full Navigating LISTdata help document, click here. 

Maps 
Can I buy a copy of a Tasmanian map or historic chart online? 
You can order from an extensive range of Tasmanian maps, historic charts and other products via 
the TASMAP eShop, www.tasmap.tas.gov.au. Payment is by credit card.  

Alternatively, you can purchase or order maps over the counter from Service Tasmania shops – click 
here to see the location of Service Tasmania shops around the state. 

For more information, see the TASMAP page of the DPIPWE website. 

Can I buy Tasmanian maps in digital format? 
You can order a range of digital maps from the TASMAP eshop.  

For more information, see the TASMAP page of the DPIPWE website. 

Where can I get further support? 
LIST YouTube channel 
A range of help videos are available on 

LIST Help documents 
Specific LIST help documents are available for the LIST Properties and Titles, LISTmap, and 
LISTdata. 

• LIST Properties and Titles

• LISTmap

• LISTdata

LIST Helpdesk 
Feel free to contact our helpful Client Services team by: 

• Phone: (03) 6165 4444 or

http://www.thelist.tas.gov.au/
http://www.youtube.com/user/gsbclientserv
https://data.thelist.tas.gov.au/
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/listdatahelp.pdf
http://www.tasmap.tas.gov.au/
http://www.service.tas.gov.au/about/shops
http://dpipwe.tas.gov.au/land-tasmania/tasmap
https://www.tasmap.tas.gov.au/
http://dpipwe.tas.gov.au/land-tasmania/tasmap
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/properties.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/listmaphelp.pdf
https://www.thelist.tas.gov.au/app/content/the-list/news_and_information/resources/listdatahelp.pdf
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• Email:   listhelp@dpipwe.tas.gov.au

LIST Facebook Page 
Like us on  

http://www.thelist.tas.gov.au/
https://www.facebook.com/pages/Land-Information-System-Tasmania/244482065691729
mailto:listhelp@dpipwe.tas.gov.au
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